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0.2 Document 
Only integer versions are authorised for development. 

Version No. Date Summary of Changes and Reason for Issue Associated Change 
CWO, CP, CCN or 
PEAK Reference 

e 

- 

0.3 Review Details 
See POA Reviewers/Approvers Matrix (PGM/DCM/10N/0001) for guidance on completing the lists below. You may 
include additional reviewers if necessary, but you should generally not exclude any of the mandatory reviewers 
shown in the matrix for the document type you are authoring. 

(date by which comments should be returned) 

• (author's email) + POA Document Management 

It preterred you can delete the toilowing Mandatory and Optional reviewer tables and paste in the appropriate list 
copied from POA Reviewers/Approvers Matrix (PGM/DCM/ION/0001). 

(* ) = Reviewers that returned comments 

• FTT•I Ii.i.iuiiiti .iI1 mci I IFi i 

References should normally refer to the latest approved version in Dimensions; only refer to a 
specific version if necessary. 
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(DO NOT REMOVE) Role Matrix 

Alphabetical order 
please 

SVM/SDM/PRO/4317 Latest See Dimensions POL Horizon Defects Review Terms 
of Reference 

Dimensions 

SVM/SDM/PRO/0875 Latest See Dimensions Application support Strategy Dimensions 

CS/MAN/01 1 

Alphabetical order please 

HDR Horizon Defect Review 

HDR-FIN Horizon Defect Review — Financial Impact 

HDR-EXP Horizon Defect Review — SPM Experience 

Sub Post Master SPM 

PBS Payment and Banking Service 

PROD OUT Production Out Date 

SME's System Matter Experts 

HTML Hyper Text Markup Language 

PNG Portable Network Graphics 

JPEG Joint Photographic Experts Group 

CBIF Customer Business Impact Forum 

POL Post Office LTD 

MGT Management 

TfSNow TRIOLE for ServiceNow 

PEAK Peak Incident Management System 

.7 Changes Expected

®8 Accuracy 
Fujitsu Services endeavours to ensure that the information contained in this document is correct but, while every 
effort is made to ensure the accuracy of such information, it accepts no liability for any loss (however caused) 
sustained as a result of any error or omission in the same. 
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The author has assessed the information in this document for risk of disclosure and has assigned an information 
classification of FUJITSU CONFIDENTIAL (INTERNAL USE ONLY). 
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This document describes the way in which the various internal and external Defect Management reports 
are produced for LIVE Defects including branch impacting. It can be used as a procedural document that 
can be referred to and updated in line with changes and/or improvements that are made to the Defect 
Management reports as they evolve and change owing customer or internal requirements. 

EJ1!11 • 
w i c.•. 

• If the Live Incident or Live Defect affects, or could affect, branch operations, we share it with 
POL in a weekly HDR Report and at the Horizon Defect Review (HDR) weekly meeting 

I =MI •. • . Ii tó 

• The Defect Management reports are produced for internal and external distribution in order to 
demonstrate Fujitsu's management and communication of the LIVE affecting defects including 
those that have a branch impact. 

• The LIVE affecting defects reported to POL will have one or more of the following collections 
added in order to qualify as a candidate for reporting: 

o ##LiveAffectingDefect 

o HDR-FIN — Horizon Defect Review — Financial Impact 

o HDR-EXP — Horizon Defect Review — SPM Experience 

• These Defects could be in various stages whilst reporting on them to POL: 

o INVESTIGATING - A Live Defect will start out as a Potential Live Defect until sufficient 
investigation has taken place 

■ [Fujitsu internal unless linked to a bonded Incident] 

o SOLUTIONING - If a fault is confirmed then this will progress to be a Confirmed Live 
Defect (if it is not a fault then the Potential Live Defect will be closed) 

■ [Fujitsu internal as a solution still needs to be identified and agreed] 

o PROPOSED FOR - Once a solution is identified for a Confirmed Live Defect it will need 
to go through the POA processes before the fix is assigned to a sensible Release 

• [Fujitsu internal involving developer / feature conflict check. Counter defects are 
discussed with POL] 

o TARGETED AT - Releases are then managed through to deployment to Live 

• [Visible to all parties as the Release work starts] 

• ` !D]iiD1ilI' - air • 
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2.1 Weeky HDR Report Creaton Work Instructions 

To create the weekly HDR Report which is shared with POL, follow these steps: 

The criteria to be used to determine HDR reporting candidates to share with POL will be 
determined by creating a list using the following logic. The resulting list allows for the HDR 
candidates to be identified. 

o Prepare the report to send to POL 
• A spreadsheet format has been used to date so the previous week's POL "HDR Defects 

update report — dd.mm.ccyy v1.0.xlsx" submission should be used as the basis for the 
new report — removing all previous week highlighting and deleting rows scored out as 
POL have been told these are being removed. 

• Save the file as v0.1 initially and use v1.0 for the version that is shared with 
POL. As a visual reminder add WIP into cell B2 

• It may be easier to create several draft versions i.e. v0.1, vO.2, v0.3 etc during 
the creation of the report, so that it is in a state suitable to create v1.0 to share 
with POL. 

• Amend the date in F3 making sure to leave it as a text field or the title of the 
section below it will not render correctly 

Create the Peak extract to build the report from 
• Then, open any version of the "Peak_Defect_Management extract dd.mm.ccyy 

hh.mm.xlsx" spreadsheet and Enable Content and go to the Data tab 
"##LiveAffectingDefect" and click Refresh All. The password to run the embedded 
queries needs entering 3 times and is i IRRELEVANT; Save the resulting file with the 
timestamp to match when the extract was created — so it can be referred back to. Turn 
off AutoSave 

Quick filtering method: 
Go to the "HDR Report Pivot" tab 

Right mouse click on any part of the filter values at the top and choose "Refresh" 

PROD OUT Planned Date (ML , b,, K % 
,Response Category (ML c o B I 6n A acl

!Deferred

Status Mt

HDRClassification (Mr'+,.,r.,.+ l •Ic  

 (All fIi S6PY

PBS Project All ( Q Format CeRs... r.._.._ 

Count  of Summary I

X Remo ie "HDR Classifxation 

......... B Field Settings... L:_...... 

PivotTable Qptrons... -- 

Hide Field List 

Check that all the filters are accurate and match the description shown: 
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REFRESII ttBtiveAffectingDefect TAB THEN REFRESH THIS PIVOT AND CHECK THE FILTERS AS SHOWN 

oROD GUT Planned Date (Multiple Items( -1 Check PROD OUTPianned Date only ticks the blanks andfuturedates .. . ..... ........ 
Response Category (Multipleltems( .T Check the NFF Response Categories are all unticked 

StatUS (Multiple Items( .T Untick C 

HDR Classification (Multiple Items( -T Set to Impact and Experio-e(Error reeds looking at, blank is excluded( 

Deferred (All( Set to Yes or blank 

Pot Project (All) Set to Yes Or blank 

Double click the number shown to expose the result set for reporting & rename the tab to Deferred/PBS/Other 

Count of Summary 
55 

• Ensure that you have set Deferred and PBS Project to (All) 
• Pay special attention to the "PROD OUT Planned Date" which may have had new future 

dates added that need to be ticked 
Call Type Defect Identified .5 S 

PROD OUT Planned Date (Multiple Items) .T S 

Respor ;t 1D L 
Status [1 9/01/2021
HDRCI '...n03/04/2022 S 
Target i. . [103/02/2022 E 

BIF Plat .-[ 1'2/02.2022 E 

PTF Pla 623/02/2022 S 

BIF Tic '-6 16/03/2022 E. 

Actions n 11/02!2022 5

[131/03/2022 C

L~ 01/05{2022 
COuntt _. 

Select Multiple Items L 

-OK Cancel 

o List — Deferred, Project and HDR Live Defect Peaks 

PROD OUT Planned Date (Multiple Items)

Response Category (Multiple Items) Tr 

Status (Multiple Items)
HDR Classification (Multiple items) 0T.

Deferred (All) 
PBS Project (All) 

• If there are any Deferred, Project and HDR Peaks to consider, a number will appear 
under the Count of Summary 
Count of Summary 

1..._... , , _ 30 
O Double click on the number to open a new sheet with the relevant Peak(s) listed 

and rename it "HDR Report" 
O It is more likely that the result set largely matches the previous results showing 

in the HDR Report. Alternatively, you can create vO.1 using the previous report. 
O Compare the previous HDR report to the new list and amend accordingly so the 

new HDR report list matches what the system now shows 
o To do this it is worth hiding the following columns as it makes to easier 

to compare the data against the previous HDR Report: 
■ B — Summary 
■ C — Date Opened 
■ D — Product 
■ E — Product Group 
■ G — Priority 
■ H — Assignment Team 
■ I — status 
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■ J — Response Category 
■ K — Root Cause 
■ M — References 
• N — TFSNow Reference 
• 0— POL SNOW Reference 
• P — Contact Name 
• R — Business Impact 

It is good idea to mark for each Defect PEAK the "Call Reference", "Description", "Target 
Release Type" and "Target Release" red on the HDR Report tab of the 
"Peak—Defect—Management extract dd.mm.ccyy hh.mm.xlsx" once checked against the 
report. 

PCO302313 

a .. 
DEV . PIN Pa Defect Ideni ##LiveAffectir No The PIN Pad status Proposed For HNG-X 73.10 

PC0301681 SV&1:72 30:E Defect Iden' HDR-Fin, ##LivYes During Existing Rev Reported In HNG-X R I, Ind. 
PC0301437 Transacttor 1 Defect Ideni HDR-Fin, ##Liv Yes If a counter perforr Targeted At HNG-X72.30 
P00303364 BTS reports' Defect Iden+HDR-Fin, ##LivYes After a failed stock Taa geted. At HNG-X 72.30 
PC6301299 BAIL. fix - INC Defect Ideni.SSC3rd, ##Livf Yes If a clerk uses the T Targete:,' At HNG-X 38.07 
PCO301174 Cusco'ner cc Defect den HDR-Fin, ##LivYes During this basket f Proposed For HNG-X 73.10 1 
PC0300404 DEV - Transa Defect Iden+##LiveAffectir No If Transaction Log s Targeted At HNG-X 72.30 
007300330 Counter Fix Defect Iden'.SSC3rd, ##LivfYes If a clerk uses the T Proposed For HNG-X 73.10 
000300066 PBS: INC 102: Defect IdeniHDR-Firs,t#LivYes Declined transactio Reported In HNG-X Rd. Ind. 
064299783 PBS Bankir,g Defect Iden. HDR-Fin, ##LivYes This issue is the resTa geted At HNG-X 72.30 
PCO299322 Branch 2508' Defect Ideni HDR-Fin, ##LivYes AP Transaction (AulTargeted At HNG-X 37,01 
PCO298994 PBS Comple Defect Iden'##LiveAffectir No If a PBS Balance Ent Proposed For HNG-X 73,10 
PCO298823 PBS: Regress Defect Iden' HDR-Fin, ##LivYes In rare cases, preveTargeted At HNG-X 72,20 
700298591 PBS transact Defect Iden' HDR-Fin, .SSCFYes if the user presses Targeted At IHNG-X 72.20 
703298324 PBS Courter Defect Iden'.SSCRandR, ## No On PBS counters wl Targeted At HNG-X 72,20 
00029S067 LST:R7110 - Defect Iden,##LfveAffectir No Business impact: Vs Proposed For HNG-X 73.10 
700297965 LST:R71..10 - Defect Ideni ##liveAffectir No Business impact: If Proposed For HNG-X 73.10 
003297964 LST:R71.10 - Defect Iden' ##LiveAffectir No During Existing Rev Proposed For HNG-X 73.10 
PCO297963 IST'R 9110 -1 Defect Ident ##LiveAffectir Yes There have been n' Proposed For HNG-X 73.10 
000297962 LST:R71.10 - Defect lden##LiveAffectir No Existing Reversals I Proposed For HNG-X 7.3.10 
PC3297878 PBS LT P71 Defect Ideni BIFApproved, No When a PBS bankinTargeted At HNG-X 72.20 
PCO295854 LST:870.40 C Defect Iden' BIFApproved, No  PBSIL does not imp Proposed For HNG-X 7.3.10 
PCO294925 Obsolete He Defect Iden! Sattars, .SSCCF No When help pages hTargeted At HNG-X 72.20 
2053293565 CBB-56536 - L Defect Iden'##LiveAffectir In particularly rare' Proposed For HNG-X 73.10 
700293598 770 40: ATO Defect Ident BlFApproved, No For AP-ADC transacTargeted At HNG-X 72.20 
000292825 INC7179923 Defect Iden'SSC- 4th Line, No See Title, this is be Proposed For HNG-It 73.10 
PCO292708 CBB-5259 - H Defect Ident BlFApproved, The history text geProposedFor HNG-X73.10 
200290005 LST:REL IND Defect lden'BIFApproved, No When the Clerk alt Proposed For HNG-X 73.10 
700289922 1ST: 870.20 C Defect Ideni BIFApproved, Yes During a Rem Info Proposed For HNG-X 73.10 
200289127 R70,20 SV&t Defect Iden BlFApproved, For some back offerargetesAt HNG-X72.20 

Any that have been closed should be moved to the HDR Closed Defects section of the 
HDR Report and highlight in yellow: 
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`

Any that are new should be added to the list and highlighted in red on the HDR Report 
tab whilst they are checked and completed 

o These then need scrutiny to ensure they look correctly tagged as HDR. 
This will require the Peak to be read and checked 

o If they are HDR, then the Impact tab needs checking to ensure it is 
complete and reads well. Any amendments should be referred to the 
SMEs for updates to be added to Peak 

o When the report is ready to submit, the highlighting on the new rows 
should be changed to yellow 

o Extract the list showing: 
ier, 

o POL Reference (from column BI) 
o POL Title (from column BN or set to N/A for a new entry) 
o Category (from column BF) 

© Copyright Fujitsu 2022 FUJITSU CONFIDENTIAL (INTERNAL USE Ref: SVM/SDM/PRO/4695 
ONLY) 

Version: 0.1 
UNCONTROLLED WHEN PRINTED OR Date: 03-OCT-2022 

STORED OUTSIDE DIMENSIONS Page No: 10 of 7 



FUJO0232857 
FUJO0232857 

POST OFFICE ACCOUNT DEFECT MANAGEMENT REPORTING 

J: FUJITSU CONFIDENTIAL (INTERNAL USE ONLY) • 

o Fujitsu Reference (the Peak Call Reference from column A) 
o Summary (the Peak Summary field from column B) 
o Confirmed Defect (set to "Yes" if Call Type in column F is "Defect 

Identified" or "No" otherwise) 
o Workaround (from column Q) 
o Update (manually updated to pick out any changes made week to week 

on the Peak in question — if nothing has changed (as is typical once a 
Peak is Targeted At) then the "No change since dd/mm/ccyy" will 
probably be ok to leave as is. If any updates are identified, set this cell 
to YELLOW FILL 

o Target Release Type (from column S) 
o Target Release (from column T) 
o HDR Extract 

■ Create the file to embed: 
■ This is created within Peak from the Impact tab 
• Open the Peak and go to the Impact tab 

IM f,:nfics F x ('xf .m ('aan.aW nw(iku.. . 

■ Click on the Export icon on the top right 

• A view of the Impact screen is presented in a new window 
• Right mouse click and choose "Save as" 
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■ Save the file 
o Embed the file 

■ Click on the cell into which the saved HTML file is to be 
added 

■ Click on the Insert menu option at the top 

orne Insert Page Layc 

• Click on Object in the Text section 
" WordArt 

t  ! 

1 r

J Signature Line 
Text Header 

Box & Footer Object 

Text 

■ Click on the "Create from File" option on the screen that 
appears

Create tie, Create from File 

File name: 

M lisktotoe 
Q Qispia}' as icon 

Result. . . _. . 

inserts the contents of the the into your 
document so that you can edit it later 
using the program which created the 
source life. 

oK Cancer 

■ Click on Browse and then navigate to and click on the 
relevant file and select "Insert" 

■ Then click OK 
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■ The file will be inserted into the cell in the HDR report 
o Screenshots 

■ If any screenshots have been requested or are needed, first 
save the screenshot to a file (PNG or JPEG) 

o Embed the file 
• Click on the cell into which the saved HTML file is to be 

added 
• Click on the Insert menu option at the top 

orne Insert Page Lay< 

• Click on Object in the Text section 

of M ~1 wordArt 
ca 

L=a Signature Line 
Text Header --77
Box & Footer rJ] Object 

Text 

• Click on the "Create from File" option on the screen that 
appears 

Object ? X 

Create New Create from File

File name; 

Q link to file 

[3 Disptpy as icon 
Result.... .

Inserts the contents of the tile into your 
document so that you can edit it later 
using the program which created the 
source file. 

Ott Cancel 

• Click on Browse and then navigate to and click on the 
relevant file and select "Insert" 

• Then click OK 
• The file will be inserted into the cell in the HDR report 
• If it is a PDF document you will need to click on Display as 

icon checkbox 
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Chw,w jcon.... 

..ii - cwcc 

o Click OK and then resize the PDF document in the cell 
o Once all details are added please ensure that all the row illustrating the 

new Defect is highlighted in yellow. 

X 

FYI ONLY — MANUAL FILTERING 
o If the HDR Report Pivot is absent or corrupted, then the manual filtering is as follows 
o Go to the ##LiveAffectingDefect tab and filter as follows: 

• Set the filter on Response Category [column J] to exclude the No Fault Found values 
(see Appendix A) 

• Set a filter on HDR Classification [column BF] to exclude blanks 
• Set a filter on Planned Out Live [column AH] so the dates are in the future or blank (it 

has not been deployed) 
• Exclude closed Peaks where Status [column Il ls "C" — as these may have been fixed 

outside of a release by Ingenico themselves 
o Then the 1 List needs to be created that can be used to compare against the previous week's 

report: 
o Deferred Live Defect Peaks 

• Set the filter on Deferred [column BH] to "Yes" 
• These are unlikely to be discussed at HDR as they are previously approved and 

understood but are provided to show the level of Fujitsu control 
o Project Live Defects 

• Set the filter on PBS Project [column BG] to "Yes" 
• These are unlikely to be discussed at HDR as they are part of the ongoing Project 

Manager regular review calls 
o Non-Project Live Defects (likely originating from an Incident during normal service delivery) 

• Change the filter on PBS Project [column BG] to exclude "Yes" 
• These require more comprehensive information as these will be discussed at the 

HDR meeting 
• Extract the list as described above 

o These previously were listed as individually in their own sections but is now reported all together. 
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2.2 Weekly CBIF Submission Extract Work instructions 
To identify if there are any CBIF submissions necessary to POL, follow these steps: 

Create the Peak extract to build the report from 
Open any recent version of the "Peak_Defect_Management extract dd.mm.ccyy 
hh.mm.xlsx" spreadsheet and Enable Content and go to the Data tab and click Refresh 
All on each tab. The password to run the embedded queries needs entering 3 times and 
isLIRRELEVANT Save the resulting file with the timestamp to match when the extract was 
created — so it can be referred back to. Turn off AutoSave 

o Quick way 
Go to the "CBIF Peaks Pivot" tab 

Right mouse click on any part of the filter values at the top and choose "Refresh" 
Call Type Defect Identified :-T Set to D 

PROD OUT Planned Date (Multiple Items) -T Set to ft 

.Response Categor I_akbri .. p A A" 'H % 

Status 
 A .

'.. NOR Classification 

Target Release Ty 
f^r ut. 

SIP Planned Date =7 copy 
PTF Planned Date [ormt Cells... F 
BIF Ticked Quest — --- --- E 
ActionedTeant l Refresh 

Count of Summate 
X P.emovc "Target Release Type" 

Field Settings.-

--........a 
Protlable Options._ 

_....._. : 'r l'. Hide Field Lrct 

Check that all the filters are accurate and match the description shown: 
REFRESH #ItLlveAffectingDefect TAB THEN REFRESH THIS PIVOT AND CHECK THE FILTERS AS SHOWN'. 

Call Type Defect Identified -T Set to Defect Identified 

PROD OUT Planned Date (Multiple Items) .T Set to future date or blanks 

Response Category (Multiple Items) '-T Untick the No Fault Fourc categories 
Status (Multiple Items) •T. Exclude C 

HDR Classification (blank) -T Set to blanks 
Target Release Type (Multiple Items) ;-T Exclude Targeted At '..
BIF Planned Date (Multiple Items) -T Exclude blanks 

PTF Planned Date (blank) .7. Set to blanks 

BIF_Ticked_Questions (Multiple Items) .T Exclude blanks

Artioned Team (blank) T Set to blanks 

Double click the number shown to enpose the result set (usually nothing) 
Count of Summary 

Pay special attention to the "PROD OUT Planned Date'" which may have had new future 
dates added that need to be ticked 
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Call Type Defect Identified .T 5 
PROD OUT Planned Date (Multiple items) -Y 5 
Respor ,- L 

Status :r i 9/01/2021 '.n 'E 
HDRCI: !...803/04/2022 S 
Target :-003/022022 E 

BIF Plat ❑ 12102/2022 E 

PTF Pla 23/02/2022 S. 

BIF Tic L I 16/03!2022 E 

Actione -Ii ?1/02/2022 , ....... 

31/0312022

R 01/0512022
Countt 

0 Select Multiple Items 

OK Cancel 

• If there are any CBIF Peaks to consider, a number will appear under the Count of 
Summary 

Count of Summary 

O Double click on the number to open a new sheet with the relevant Peak(s) listed 
O Go to "Collating the results" below 

O Manually filtering way 
• Go to the ##LiveAffectingDefect tab 

• Call Type [column F] is "# - Defect Identified" (a fix is needed) 
• Set the filter on Response Category [column J] to exclude the No Fault Found values 

(see Appendix A) 
• Set a filter on HDR Classification [column BF] to blanks 
• BIF Planned Date [column U] must not be blank (it has to have been to a BIF meeting) 
• Target Release Type [column S] is not Targeted At (as this means it has gone through 

PTF already) 
• PTF Planed Date [column AA] must be blank (it has not been to PTF) 
• Planned Out Live [column AH] date is in the future or blank (it has not been deployed) 
• The Actioned Team [column AJ] must be blank (i.e. not BIF (not ready for CBIF) or PTF 

(gone past the CBIF step)) 
• BIF_Ticked_Questions [column AM] is not blank (BIF selected it for CBIF) 
• Go to "Collating the results" below 

o Collating the results: 

• Check that each Peak(s) in the result set is/are correctly marked by reviewing the Peak 
Details and looking at the Release Management (Release MGT) tab for notes that 
clarify. Any Peaks that are confirmed as CBIF candidates then need a CBIF Proposal 
creating as this is what will be submitted to POL. 

• CBIF is part of the HDR meeting and any proposals should be submitted along with the 
weekly HDR report for discussion at the weekly HDR meeting with POL. 
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Appendix A No Fault Found Response Category v lues 
Peaks with the following Response Categories are deemed to be No Fault Found as no action was 
required to remedy the issue raised. In some cases this is because the fault is within an area of the 
system that is managed using TfSNow and hence Peak is not the source of the Live Defect information. 

Response Category - 68 -- Final -- Administrative Response 

Response Category - 95 -- Final --Advice after Investigation 

i Response Category - 94 -- Final -- Advice and guidance given 

Response Category - 70 -- Final -- Avoidance Action Supplied

Response Category - 200 -- Final -- Call withdrawn by user 

Response Category - 120 -- Final -- Cloned to create Defect Peak 

Response Category - 72 -- Final -- Duplicate Call 

Response Category - 58 -- Final -- Documentation Fix Available to Call Logger 

Response Category - 66 -- Final -- Enhancement Request 

Response Category - 96 -- Final -- Insufficient evidence 

i Response Category - 62 -- Final - No fault in product 

I 
Response Category - 63 -- Final -- Programme Approved - No Fix Required 

i Response Category - 64 -- Final - Published Known Error 

Response Category - 100 -- Final -- Route call to TfS 

Response Category - 97 -- Final -- Unspecified insufficient evidence 

Response Category - 98 -- Final -- User error 

2.3 UpJaUng the PIVOT Tab of the Weeky Defect Update 
deport 

The Pivot tab of the Weekly Defect Update report provides a table and graph that illustrates 1) 
The Proposed For 2) Targeted At 3) TBC for the Defects displayed in the HDR Report - Open 
Defects by Target Release and HDR collection i.e. Impact and Experience. 

If no new defects are added to the report, then the table and graph can be refreshed to pick up 
any changes by following the below steps: 
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• On the Pivot tab, select a cell within the table and then right click, to bring up the menu 
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• On the menu click on refresh to update the table and graph 
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• If new defects have been added to the HDR Report — Open Defects then select the 
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• Then select Change Data Source from this meu click on Change Data Source 
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The Change PivotTable Data Source menu will be displayed 
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. Change the Table/Range to cover all the active rows and then click ok 

This will then return you to the Pivot Tab 
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. Again it is worth refreshing the table. 
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2.4 Providing updates to POL Questions in ting and 
additional questions 

As a result of the weekly HDR meeting there maybe questions raised by POL that you will need 
to read the Defect PEAK or engage the required technical resource to gain the required updates 
to add to the Impact Tab so a revised HDR Extract can be provided in the next HDR Report. 

Additionally, POL may send questions on HDR Defect PEAKS in order to gain clarification, that 
will again need to be added to the Impact Tab so a revised HDR Extract can be added to the 
HDR Report. 

These actions can be performed outside of the producing of the weekly HDR Update Report in 
order to be ready to add the report against the appropriate HDR Defect PEAK in the report. 

• Once all the required changes have been added to the HDR Report, you are know in a position 
to create v1.0 to send to POL by approximately 10:00 on a Friday morning, in preparation for the 
HDR meeting with POL on a Monday morning (Usually 11:45). If you send it a little late owing to 
awaiting an update from a technical resource, that is not a big issue as long as it is sent to POL 
by close of play on the Friday. 

o Open the latest draft version of the report i.e. HDR Defects Update Report v0.2 

o Ensure that all the required updates, HDR Extracts and Screenshots have been added to 
the report. This includes checking against the actions from the minutes of the previous 
meeting sent by POL in order to ensure that the required information to answer POL 
questions is included in the HDR Extracts for the appropriate HDR Defect PEAKS. This 
will assist in confirming the status of the Fujitsu actions from the previous meeting. 

o If so, remove the word "WIP" into cell B2 and save the report as "HDR Defects update 
report — dd.mm.ccyy vl .0.xlsx" 

o Next prepare the email to be sent to POL that the report needs to be attached to. Please 
see example of the weekly email for the HDR Update Report below: 

From: Hatch, Matthew 
Sent: Friday, September 30, 2022 10:12 AM 
To: Paul I Smith GRO l; Lisa.milla ._._. ._....._._.__. 

Browell, Steven 
i GRO Bothick, Sandie -_._._ -- - - _GRO _ __._._._._._,_._._- POA 
DutyManagerl_._._._._._._._.

.__.__.__._._._._._. 
GRO 

. ---- - 
;> 

Subject: HDR Defects Update Report -30.09.2022 - v1.0 

Good Morning Paul and Lisa, 

There are NO CBIF candidates to put forward this week and NO NEW DEFECTS to 
raise. 

There is also FOUR updates to the existing entries, that have been highlighted in yellow 
in the update column. 

Changes to report and updates: 

• The pivot has been updated 
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The four updates are: 
o 1 has had the Target Release updated. 
o 1 has Status Update amended to reflect POL questions 
o 1 has RCA updated etc amended to reflect POL questions 

■ Already provided revised HDR to POL on Monday 26th of 
September. 

o 1 has the latest problem update. 
The one closed defect from last week: 

o PC0302653 - Invalid session receipts printed before session settlement 
& user confused as to how to settle it 

■ The HDR extract has been updated to reflect POL accepting 
that this is not a defect and is working as per design, as result of 
meeting held on Wednesday 28th of September. 

There are NO OPEN ACTIONS for Fujitsu — as I have engaged technical resources and 
updated the HDR Extracts for the below: 

• PC0302313 DEV - PIN Pad Record Not Updated To Show When 
Responsive/Non-responsive during logon or unlock 

• PC0302653 Invalid session receipts printed before session settlement & 
user confused as to how to settle it - (closed) 

o Meeting held on Wednesday 28th of September as highlighted above. 

I approve the minutes from the HDR Meeting on Monday 26/09 from a Fujitsu 
perspective. 

o Then add the report version 1.0 "HDR Defects update report — dd.mm.ccyy v1.0.xlsx" to the 
email and send to 

iji iixsiITh 
In order to have an audit record of the HDR Defect Update reports, emails sent to POL and emails and 
minutes of the meetings sent by POL to Fujitsu, there is a sharepoint location whereby all of these 
emails and documents are held. Following the sending of the weekly report to POL, or responding to 
POL emails with questions or the receiving of meeting minutes from POL please save them to the below 
sharepoint location: 

Service Management - Horizon Defects Review (HDR) - started June 2021 - All Documents 
(sharepoint.com) 

2.7 LIVE Defect Management Monthly Report Creation 
To create the monthly Live Defect Management for POA stack owners and leadership, follow these 
steps: 

Create the Peak extract to build the report from 
• Then, open any version of the "Peak_Defect_Management extract dd.mm.ccyy 

hh.mm.xlsx" spreadsheet and Enable Content and go to the Data tab and click Refresh 
All on each tab. The password to run the embedded queries needs entering 3 times and 
is`IRRELEVANT Save the resulting file with the timestamp to match when the extract was 
created — so it can be referred back to. Turn off AutoSave 

Prepare the report 
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• A spreadsheet format has been used to date so the previous month's 
"POA_Live_Defect_Management Monthly Report dd.mm.ccyy hh.mm.xlsx" should be 
used as the basis for the new report. To show history, copy the white box on the top left 
of the Summary tab and paste it to the right as an image (you may need to delete a 
previous image) 

• Save the file with the same date and time values as the Peak extract created earlier so 
you know which extract the report relates to 

Go to the ##LiveAffectingDefect tab and filter as follows 

Then the 5 tabs are derived as follows: 

Check the range of values in the Call Type column. If there are any that are neither "Live Incident" 
nor "Defect Identified" then these need to be looked at to decide whether to treat them as one of 
these 2 categories. There shouldn't be any, but if there are, it is most likely to be Vulnerability which 
can be treated as Defect Identified. If so, amend the filtering below where ** is shown. 

o Still Investigating 
• Clear all filters 
• Filter the Planned Out Live date so it is in the future or blank (it has not been deployed) 
• Filter out the No Fault Found Response Category values (see Appendix F) 
• Filter Call Type to "Live Incident" ONLY ** 

• Consider filter on Status to exclude "C"losed — but beware the closures may be 
wrong 

• Extract the columns shown on the tab from the filtered list and paste the values into the 
report 

• Expand/contract the Stack owner column by copyingipasting the formula so all rows are 
attributed to a name 

o DI — Solutioning 
• Clear all filters 
• Filter the Planned Out Live date so it is in the future or blank (it has not been deployed) 
• Filter out the No Fault Found Response Category values (see Appendix F) 
• Filter Call Type to "Defect Identified" ONLY ** 
• Filter "Target Release Type" to exclude "Targeted At" and "Proposed For" 

■ Consider filter on Status to exclude "C"losed — but beware the closures may be 
wrong 

• Manually add back in any that are "Targeted At" or "Proposed For" and Target 
Release is "Re-target" if there are any 

• Extract the columns shown on the tab from the filtered list and paste the values into the 
report 
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